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Configuring the MachineLogic and MachinePoint I\O System for DeviceNet

INTRODUCTION

This document will describe the steps necessary for configuring MachineLogic and the CTC Parker MachinePoint I\O bus coupler for DeviceNet.  This tutorial will include sections explaining the following:

· How to mount and wire the MachinePoint I\O

· An explanation of the MachineLogic hardware

· How to configure the bus coupler and the PowerStation

· How to configure your MachineShop project for DeviceNet

· Addressing and memory information

· A list of error codes for the CTC Parker DeviceNet I\O

In addition to your PC and PowerStation, you will need the following items:

· Interact v6.0 or higher

· MachineLogic v2.0 or higher

· MachineShop Toolbar v1.0 or higher

· SST Configuration Utility for DeviceNet I/O

· SST UCS or SST-UCS-PC/104

· 10 Mb or greater PowerStation Flashcard

· I/O Simulator

· DeviceNet cable (to be discussed)

MOUNTING THE MACHINEPOINT COUPLER AND I/O
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Begin by mounting the MachinePoint bus coupler on a piece of din rail by placing the top over the din rail and snapping the bottom on.  Then add the I/O modules to the right of the coupler.  Snap the orange clip on top of the modules in place.  The orange clips allow the communication over the back plane.

WIRING THE BUS COUPLER
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Wires should be stripped back about 8 mm before placing them in the hole while the clamp lever is in the down position.  After placing the wire in the hole use a screw driver to disengage the clamp lever so that it pops up.  When the clamp lever is pushed up the clamp will close solidly on the wire.
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To supply power to the MachinePoint, the positive wire of the power supply should be connected to the red +24V location on the bus coupler.  Add the ground voltage of the power supply to the blue “0v” location on the bus coupler.  Next, add a wire from the 0v location to the ground of the bus coupler.  To supply power to the other modules, connect a wire from the +24V of the bus coupler to the +24V of the next I\O module.  Repeat this for the 0V and the ground wire.

ADDING A DEVICENET CABLE
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A DeviceNet cable must be constructed to reflect the following.  To begin, we must supply power to the cable and the I\O network.  To do this, power can be taken from the +24 volts of the power supply and combined with the red wire of the DeviceNet network cable.  The 0V connection can be combined with the black wire of the DeviceNet cable.  Both ends of the DeviceNet cable will be wired the same.  Pin assignments should be connected using the following:

PIN
COLOR
DESCRIPTION
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A 121-Ohm terminating resistor should be placed between pins 2 and 4 of the cable end of the last device on the DeviceNet network.  If you only have one node (i.e. one bus coupler) you will still need to connect a resistor at the bus coupler end of the DeviceNet cable.  The UCS cable end (the one connected to the PowerStation) does not require a resistor.

THE MACHINELOGIC CONTRLOL ADAPTER CARD
The MachineLogic Control Adapter is an expansion card that must be installed in the runtime workstation in order to run MachineLogic.  There is a connector on the MachineLogic card that is labeled J5.  This connector is used to program some of the devices on the MachineLogic card and will not be used in the field.

THE UCS CARD

On the back of the P2 a UCS is card stacked on the MachineLogic Adapter Card.  This card facilitates communication between the MachineLogic adapter and the CTC Parker MachinePoint bus coupler.  There are several jumpers on the UCS card.  J1 will select between providing power for the network internally (J1 off).  This mode significantly decreases the amount of current to the MachineLogic card and UCS card as well as the P2.  It is suggested that J1 be set to pins 1 and 2 with 3 open.   Jumpers BA1 and BA2 should both be on.  BA1 and BA2 distinguish the address of the UCS card.    Up to 4 UCS cards can be stacked on each other.  Currently, MachineLogic only supports one UCS card.

CONFIGURING THE BUS COUPLER NETWORK SETTINGS
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Disconnect the bus coupler from the PowerStation and apply power to the bus coupler.  Disconnecting the bus coupler from the PowerStation is important because there can be no communication to the bus coupler at the time of configuration.  After applying power, the 24V light on the bus coupler should turn on, as well as the 24V light on all of the I\O modules.  If not check the wiring of the modules.
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First we need to set the node number of the I\O block.  To do this, press the small MODE button until the cursor is over the STOP indicator and blinking, then hit OK.  Next, press the blue left and right arrow buttons at the same time.

Use the blue arrow keys to set the node number for the I\O network.  If more than one node is on the network select a unique number for the each node (for our example we will use 3).  Once you have the desired number – press OK.

*Note:  The node number set for the bus coupler will be used several times throughout the configuration.  

Press the MODE button until the cursor is over the RUN indicator.  Then push OK.  Press the MODE button again until the cursor is over the STOP.  Do not press OK.  Press the up and down arrows at the same time.  This will enter you into the service functions.  Use the arrow key to select S02 then press OK.  Change this value to 2.  Then, press OK.  0 assigns a network speed of 125K, 1 would change the speed to 250K and the 2 will change the speed of the network connection to 500K.

CONFIGURING THE POWERSTATION

The easiest way to set up the PowerStation for the CTC Parker DeviceNet is to simply reformat the Flash disk.  The Flash Utility will restore all the PowerStation files to the Flash disk.  A shortcut can be added to the MachineShop toolbar for the Flash Utility.
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If you don’t have the utility, but have access to the Internet then you can find it at: http://www.ctcusa.com/ctcnet/Support/support.asp . Select “PowerStation Utilities” under “PowerStation Disk & Doc For MachineShop Shell” you will see FlashUtil.zip
DEVELOPMENT SETUP

The next step for setting up DeviceNet is to configure your project during development.  This will include the following:

· Creating a new MachineShop project

· I\O Configuration with the SST DeviceNet configuration Tool

· Understanding the Weiland DeviceNet addressing format
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SECTION I (MachineShop Project Creation)

Begin by launching MachineShop.  Create a new project by selecting Create a New MachineShop Project from the Welcome screen.

Enter a Project name, and select which components will be included in the project (in this case Interact and MachineLogic). Choose OK.
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Select the Template for UCS DeviceNet. Choose Next.
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Select the ‘SST DeviceNet UCS’ I/O interface. Choose Next.

Enter the Interact application name and display resolution. Choose Next.
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Choose the module(s) that you will use in your Interact application. Our example will only require the PTM module. Choose Next.
You can choose the driver(s) that you will use in your Interact application. Notice MLD for MachineLogic driver has been added automatically.

Choose Finish.
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A screen will display project information.

Choose OK.

SECTION II (I/O Configuration w/ SST)

To create the master (scanner) device, follow these steps:
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Start the SST DeviceNet Configuration Utility.

Select Insert New Node from the Edit menu.

The system creates the master (scanner) device node below the root node.

Double-click on the scanner device (Scanner1) that was added above.

The Node Properties dialog box appears allowing you to modify the properties of the master (scanner) device.
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In the General tab, click the Assign network parameters check box.  This will allow you to set the Baud rate for the bus coupler.  Next, set the MAC ID (for the UCS card) to 0, the Baud Rate to 500Kb, and the Scan Interval to 0.  Make sure that the MachinePoint bus coupler settings match (see CONFIGURING THE BUS COUPLER NETWORK SETTINGS).

Click the Apply button to save.

[image: image45.bmp]On the I/O tab, you can select the I/O Connection type, and then enter the size of the input and output data.

Select the Polled connection type.  This type of connection is the only one currently supported.

Assign 1 byte of Input and 1 byte of Output.  These are status bytes that are used between the UCS and MachineLogic cards.
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Click the Apply button to save.

On the Tags tab, click the New button to create a tag. You will need to create a Status tag for your MachineLogic project.
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The Tag Properties dialog box appears.

On the Tag tab, you can select the type of tag, and then enter the settings for that tag.

Select Server Status, click OK.

Click OK to close the Tag Properties dialog box.

Click OK, to close the Node Properties dialog. You are now ready to create a generic slave device.

To create a generic slave device, follow these steps:

In the Configuration Tree, select the master (scanner) device.

Select Insert New Node from the Edit menu.
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The Select Device dialog box appears.

Select Basic Device, and click OK.

A new device is added below the master (scanner) device.

Double-click on the device you just added.

The Node Properties dialog box appears.

Change the Product Code, Vendor ID, and Device Type to match the figure to the right. The remaining parameters will automatically fill in.

*Note:  Make sure the Mac ID matches the node number you set on the bus coupler (see CONFIGURING THE BUS COUPLER NETWORK SETTINGS).

Click the Apply button to save.

Select the I/O tab.

Select the Polled connection type.

Enter 14 for the Input bytes, and enter 14 for the Output bytes.  (This information will be explained in the MACHINELOGIC ADDRESSING section of this document)

Set the Update interval to 0 ms.

Right-click on the Scanner1 area of the menu, and select Export.

The UCS Personality Save As dialog box appears.

Browse to the location where your project holds the configuration files to be downloaded to the PowerStation. In our case: C:\MachShop\projects\config\<Project, where <Project> is the name of your project.  Name the Binary file UCSDVNT. This will create a .UCP binary file that will be read by MachineLogic in Run Mode.

It will also be helpful to save this configuration.  That way you will be able to comeback to and make changes if necessary.  To do this, choose Save under the File menu.  It is suggested that you save the *.dnc file to the following location:  C:\MachShop\Projects\Interact\<Project>\Startup\UCSDVNT.DNC.

You can now close the SST Configuration utility. If you have not yet saved, you will be prompted to save the file. We have exported the file necessary for MachineLogic’s use and saving this file is optional. It is useful, however, to save this file for future enhancements or changes.

TO EDIT THE UCSDVNT.INI file, follow these steps:

The computer will look in the USCDVNT.INI file for the name of the personality file you exported from the SST DeviceNet Configuration Tool to the UCSDVNT.INI in your project directory.

Make sure MachineLogic has been loaded onto your development PC.

Browse to the Project directory. This directory is C:\MachShop\Projects\Config\<Project>.

Open UCSDVNT.INI in a text editor, such as Notepad.  At the CfgFileName parameter, add the name of the personality file you exported from the SST DeviceNet Configuration tool.  Save UCSDVNT.INI, and exit the text editor.

ADDRESSING INFORMATION

When addressing I\O points wired to your CTC Parker I\O block there are a couple of things to keep in mind.  First and most importantly are the status bytes associated with the CTC Parker bus coupler.  Lets look at an example of an I\O setup.  In this example we will use a MachinePoint DeviceNet bus coupler, an 8 I\O module (which can be wired for any combination of 8 inputs and outputs), and a 4 analog input and 4 analog output module with +/- 10 volts.

The actual physical location (meaning their order of connection to the bus coupler) of the I\O modules defines how their inputs and outputs will be addressed.  For our purposes we will assume the following setup:



The figure below describes the memory layout associated with the I\O configuration on the previous page, each block represents 1 byte:
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The first 4 bytes of this system are status bytes.  Therefore, when accessing inputs and outputs of the I\O block all addressing will begin at the 5th byte (byte #4).  Also, even though our discrete module only has 8 I\O points the module still uses 2 full bytes.  In addition, the analog module uses a full word (2 bytes) for every input and output.  Below are some examples of how the addressing will look in MachineLogic:

· For the first discrete Input, the address would be: IX4.0 – where I is an input and X accesses information on the bit level

· For the first analog Output, the address would be: QW6 – where Q is an output and W accesses information on the word level

Remember that the addressing is defined by the actual physical order of the I\O modules.  If we were to switch the location of the analog and discrete modules the first input of the analog module would be at the 5th byte (byte 4).

SECTION III (MachineLogic Development and Example Application)

Launch MachineLogic by clicking on the gear icon in the MachineShop ToolBar.

MachineLogic will open with the name you designated in your MachineShop project.

Double click the Global_Variables. Go to the end of the Global_Variables list, and enter the following variables exactly as shown below:


VAR_GLOBAL


CONTACT   AT %IX 8.0

:
BOOL;


COIL
       AT %QX 4.0

:
BOOL;

     
BUTTON      AT %MX 0.0     
:   
BOOL;   

END_VAR

Save and close this worksheet.

Double-click on I/O configuration

The task name MyTask1, MUST match the I/O reference statements below.

PROGRAM INPUTS WITH MyTask1: INPUT.

(

   VAR_ADR := 0,




(* START OFFSET IN BYTES *)

   END_VAR_ADR := 13,



(* STOP OFFSET IN BYTES *)

   DEVICE := DRIVER,



(* REQUIRED *)

   DRIVER_NAME := 'UCSDVNT',

   DRIVER_PAR1 := 3

);

PROGRAM OUTPUTS WITH MyTask1: OUTPUT

(

   VAR_ADR := 0,




(* START OFFSET IN BYTES *)

   END_VAR_ADR := 13,



(* STOP OFFSET IN BYTES *)

   DEVICE := DRIVER,



(* REQUIRED *)

   DRIVER_NAME := 'UCSDVNT',

   DRIVER_PAR1 := 3

);

*Note: END_VAR_ADR will reflect how many I\O modules (in our case we used a total of 14 bytes) are connected to the individual bus coupler (see IMPORTANT MEMORY AND ADDRESS INFORMATION).  Also, DRIVER_PAR1 will reflect the node number set for the bus coupler (see CONFIGURING BUS COUPLER NETWORK SETTINGS).

Save and close this worksheet.

Double-click on the word ‘MyProgram’ under the “LOGICAL POU’s’ section on the browser tree.

Choose ‘MyProgramV’ under this section. This will open the local variables worksheet for MyProgram .

Delete the information that is currently in MyProgramV worksheet by highlighting and right clicking, then choosing Delete.

Double-click on the MyProgram worksheet and select all the data on the worksheet. Right-click and delete the data on the existing worksheet.

Click on the MyProgram worksheet and from the element toolbar located directly above the worksheet, select the contact network icon. 
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This will insert a contact and coil onto the worksheet.

Right-click on C000, and choose Object Properties.
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You will be asked to save your changes to MyProgramV.VB, select Yes.

Set Contact/Coil to Contact and the Type to normally open ( ---| |--- ). The Scope should be set to Global.

Select the pull down menu button next to Variable, and choose CONTACT. Click OK.
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Right-click on the coil symbol to the right, and choose Object Properties from the menu.

Set the Contact/Coil to Coil and the Type to the normal coil symbol. ( ---( )--- ) The Scope should be set to Global.

Select the pull down menu button next to Variable, and choose COIL. Click OK.


Finally, single click on the contact you named CONTACT, and choose the Add contact/coil below icon from the icon bar above the worksheet. This will add a parallel contact to your network.

Right click on this contact, and choose Object Properties from the menu.

Set the Contact/Coil to Contact. Set the Type to normally open. ( ---| |--- ). The Scope should be set to Global.
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Select the pull  down menu button next to Variable and choose BUTTON. Choose OK.

Save and close this worksheet.

The TASK has already been configured in this case, (MyTask1), but please note that you will need to configure a TASK if you do not have one preconfigured when working with other templates. The MachineLogic Project is complete.

Press Ctrl_F9 to rebuild this Project. You should see the following message. Remember to leave the MachineLogic program open. You can minimize the program. MachineLogic automatically saves all necessary files on compilation.
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Create a backup of your project by selecting Save Project As / Zip Project As – from the File menu.  Select *.zwt from the Save As type drop down menu.

SECTION IV (Interact Development)

Select the icon that launches INTERACT v6.0 from the toolbar.

Expand the Application Browser and select Tag Editor.
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Note that INTERACT v6.0 recognizes the use of MachineLogic in the right window.

Expand the MachineLogic application name 'New' and then expand the ‘Global-Variables’ section in the Tag Editor.

Select and drag the variables CONTACT, COIL and BUTTON in to the right window.

INTERACT will now automatically create tagnames for use in your INTERACT application.

Save and close the Tag Editor.
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In the Application Browser, expand the Panel Toolkit Module (PTM), and select Panels then New.
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Create a Momentary pushbutton with the address @BUTTON as the ‘Switch Input’.

Create an indicator tool and use @COIL in the ‘Lens Output 0’ reference location. Make sure that you set different colors under the ‘Appearance’ tab to represent the 0 and 1 states.
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Before you exit you may wish to add a Go To AM Button. This is an Action Tool.

Save and close the panel.
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Close the INTERACT program.

SECTION V (MachineShop Transfer to the PowerStation)

Turn off your PowerStation and take your Compact Flash out and insert it into your computer (use the SANDISK adapter or the PCMCIA adapter).

*Note: Do not remove the Compact Flash until the power is off.  If the Flash is removed while the power is on, the Flash may become corrupted.

Select the Transfer Wizard Icon.
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Select the Download to Runtime option.

Select Next.

Select Define New Connection.
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Type FLASH as your Connection Name.

Select the Connection Type to be Disk. Select OK.

Assign the proper Drive letter to the Compact Flash.
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Select Finish. You may be prompted to save a MachineLogic Zip file. Select Yes, and continue the operation.
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Continue through the menu selections and Begin your download. Most Downloads take only a few seconds.

If a warning appears concerning the existence of a *.zwt file, ignore the warning and select Yes.

Now put your Compact Flash back into your PowerStation, and turn on the power.

All of the necessary files should be downloaded. When you run Interact it will display your tools.

When you push the Interact push button on the PowerStation’s display, the first Input light on your simulator will go on (green). When you push the first button on your simulator (green), the indicator in Interact on the PowerStation’s display will go active.

CTC Parker DeviceNet I\O Error Codes

The following is a list of error codes associated with the CTC Parker MachinePoint bus coupler:

Error Number

Explanation

E001
No I\O module connected

E002
An I/O module with an ID not supported by the bus coupler has been connected.

E004
Internal data transmission (bus coupler (( I/O module) has been interrupted (e.g. slide contact open)

E005
The bus coupler has identified a transgression of the maximum number of I/O modules.

E006
The field bus has been disconnected or is no longer being operated.

E007
Write access to the EEPROM in the bus coupler has failed.

E012
The bus coupler has identified a configuration change and is now deleting masks for LOCK mode.

E016



User lock-out violated on safety level 1.

E017



User lock-out violated on safety level 2.

E018



More than 8 lock conditions set for analog channels.

E019



A module in the bus node has a 24V error.
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